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Zoom in (magnifying function), zoom out and mov-
ing the screen content is the subject of the first 
paragraph of this chapter, followed by the help func-

tions in GRAFIS. Then, you will learn how to output 
the constructed pattern to a printer or plotter. The 
last part of this chapter deals with stacking graded 
patterns. 
Please use the exercises at the end of the chapter to 
solidify your knowledge gained in this chapter. 
After having successfully completed this chapter you 
are able to grade and output the basic blocks con-
tained in GRAFIS and to stack the patterns. 
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Picture 3-1 
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Picture 3-2 

3.1 Alter the screen display 

Overview 
The patterns can be displayed on screen in scales 
from approx. 100:1 to 1:100. The setting is infinitely 
variable or can be controlled with certain values. 
The function keys F2, F3, F4, F6 and the arrow keys 
are used for screen adjustment. They have the fol-
lowing significance: 
 Function 
F2 Zoom in/zoom out screen contents 
F3 Drag/turn parts towards one another 

(chapter 13 or 14) 
F4 Refresh screen 
F6 Centre screen contents 

The construction is not influenced by the changes 
to the screen display. 

Drag / Zoom 
With the Drag//Zoom function in the Edit pull-down 
menu patterns can be enlarged/reduced in stages or 
moved on the screen. After having clicked 
Drag/Zoom a magnifying glass with the 
following functions appears: 
enlarge  click left mouse button 
reduce  click right mouse button 
move keep left mouse button pressed 
Enlarging and reducing ensues with the magnifying 
glass as the centre. Click the relevant points or lines 
with . Reduce with  and move the mouse with 
pressed left mouse button. 

Centre picture with <F6> 
Pressing the <F6>-key automatically adjusts the 
scale and position of the whole construction to dis-
play all objects on the screen. The construction is 
centred on screen. 

Zoom in with <F2> 
Press <F2> to zoom into the screen contents. A 
small arrow appears on screen which you can move 
with the mouse. Move the cursor to the lower left 
corner  of the area to be enlarged and click . 
Move the mouse to see how a rectangle is opened. 
Extend the rectangle to the top right (picture 3-1) 
and click again . 
The rectangle content becomes the screen con-
tents. Press the <F6> - key and your complete 
construction re-appears on screen. 
Practise zooming in on various areas of your con-
struction. Press <F6> after each zoom operation. 
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Zoom out with <F2> 
Press the <F2>-key to zoom out, also, click  the 
upper right corner, extend the rectangle to the 
lower left and click  (picture 3-2). 
The complete screen content is reduced to fit the 
rectangle. With <F6> the screen is completely 
filled again, the construction is centred. 
Practise zoom out on various areas of your basic 
block and centre the basic block again with <F6> 
each time. 

Move with arrow keys 

Use the  keys to move the picture. The 
moving speed is increased by keeping the keys 
pressed down. 
Reduce the construction and move the screen con-
tents with the arrow keys. 

Refresh screen with <F4> 
The <F4>-key rebuilds the whole screen content. 
Identical objects lying on top of each other twice, 
four or six times cannot be seen on screen as they 
delete each other’s image. Objects lying once, three 

or five times on top of each other can be seen. After 
pressing <F4> objects deleting each other’s image 
are always displayed. 
Please use this key from time to time as a means of 
control. 

3.2 When help is needed 

Overview 
⇒ Constant help in the in-

structions window or the 
status line (picture 3-3) 

⇒ Extensive help with the 
GRAFIS help function 

Constant help 
Constant help is given in the 
instructions window or the status line where the 
next steps required are explained. The instructions 
window is located in the top right corner of the 
working area. The status line makes up the lower 
border of the GRAFIS screen (see picture 3-3). Click 
delete  in the basic menu. Read the instructions 
and close the delete menu with . 

 

Info Box with short help to the
next operation.

Status Bar with the help texts of
the Info Box.

In the View pull-down menu you select
which additional windows are displayed.
GRAFIS beginners require the Status Bar
and the Info Box. As a rule, experienced
GRAFIS operators require the Status Bar

and the Toolbox, only.

 
Picture 3-3 
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3.3.2 Output to plotter/printer The GRAFIS help function 
Output of patterns to plotters (drawing devices) or 
printers ensues via the Pattern output menu. A spe-
cial feature of the pattern output function in GRAFIS 
is the automatic wrap. It allows for quick output of 
full size patterns to small scale printers by dividing 
the pattern into partial pictures which can be joined 
subsequently. 

Context related help can be found by pressing the 
<F1>-key or via the pull-down menu Help | Con-
text. 
All contents of the help function can be obtained 
with Help | Contents. A picture of the basic menu 
appears from which further help topics can be 
opened. 
A topic search is possible with Help | Search. The Pattern output menu is opened via the File | 

Plot/ Print... pull-down menu. The following applies: As soon as the 
cursor changes to a hand you can obtain 
more information about the respective 
topic. Sensitive texts are generally underlined in 
green or dotted. Sensitive areas in picture are not 
highlighted specifically. Move the cursor over the 
relevant areas of the picture and click when the 
cursor changes to a hand. 

Preparation of plot picture 
⇒ Set up or change the plot-

ter/printer (plotter type, paper 
format,...) 

Exercise: 
Press the <F1>-key in the basic menu, move the 
cursor over the picture and click the sensitive pic-
ture areas. Read the information. To return to the 
overview page click the Contents card. Close the 
help function via File | Exit or by clicking the cross in 
the upper right corner of the help window. 
Open the delete menu in GRAFIS by clicking on 
delete in the basic menu. Press <F1> and read the 
help information about the delete menu. Close the 
help window. Read also the help topics on separate 
and parallel. 

3.3 Pattern output 

3.3.1 Clipboard 
GRAFIS supports the Windows clipboard for proc-
essing patterns in other Windows applications. The 
function Copy (clipboard) in the Edit pull-down menu 
copies the visible contents of the GRAFIS screen to 
the clipboard. The contents of the clipboard can be 
inserted into other Windows applications such as 
Word for Windows95, Paint or Excel to create fur-
ther material about the style or teaching material for 
example. 
Grade a basic block in 5 sizes, centre with <F6> 
and copy the graded nest to the clipboard via Edit | 
Copy (clipboard). Now start a different Windows 
application (e.g. Paint) and insert the contents of the 
clipboard into this application. Process the graded 
nest by changing the line colour, fill in the shapes or 
add annotation for example. 

⇒ Click formatposit centred and 
press <F6> to get an overview 

⇒ Adjust the following settings: 
• portrait or landscape 
• plot scale with enlargement 
• Activate the automatic wrap 
• Position the plot frame with 

formatposit centred and/or 
dragging 

⇒ Position the frame text 
⇒ Select +/- frame 
⇒ Select +/- formfeed 

Output of plot picture 
⇒ Click plot (plot picture is gener-

ated internally) 
⇒ if required: output of  formfeed 
⇒ with automatic wrap: select the 

pages for output and start the 
plot output 

Change plotter/printer 
The selected output device is dis-
played under plot device. The exten-
sions mean: 
to LPT1 direct output to the 
parallel port LPT1 
to File a file with control in-
formation for the output device is 
generated 
(WIN) output to a device with 
Windows95/NT driver  
(DOS) output to a device 
without Windows95/NT driver 

---------------
 plot device
  HP LaserJet
  5P an LPT1
  (WIN)

  change
---------------

 enlargement
   1.0000
   adapt
---------------
 plotformat:

   297x210

p <=> l
---------------

 automatic
  wrap

 <    1    >
 <     1    >
---------------

 textpositn.
  <     4    >
---------------

  formatpos.
  centred
---------------

 plot
  - frame
  - formfeed
- cut
---------------

Plot/Print

 
 



Chapter 3 “Screen work and pattern output”  5 
_______________________________________________________________________________________________________________ 

©Friedrich: GRAFIS - Textbook for Beginners, Edition 10/98 

 
Activating automatic wrap Further information about set up or changing a plot-

ter/ printer can be found in the GRAFIS help func-
tion. For the following exercises an A4 printer in-
stalled under Windows95/NT is sufficient. 

The automatic wrap is useful for output of full size 
patterns to devices with small format, i.e. A4 print-
ers. A raster is superimposed onto the pattern (pic-
tures 3-4 and 3-5) and each field is output sepa-
rately. The partial pictures can then be joined to-

gether frame by frame. The raster is set up or elimi-
nated by clicking “>“ or “<“ below automatic wrap. 
The number of fields in vertical and horizontal direc-
tion is given between the symbols “>“ and “<“. 

The plot format 
The measurements of the active format are dis-
played in millimetres under plotformat. Other plot 
formats of your output device can be selected via 
plot device change.  
The plot frame on your screen corresponds with the 
printable area of your output device. The contents 
of the plot frame is printed. Press the <F6>-key to 
display the plot frame as well as the plot picture. 

Selection of portrait or landscape 
Clicking p <=> l toggles between portrait and 
landscape.  

Selection of plot scale 
The plot scale is adjusted by entering the scale fac-
tor in the enlargement line. The pattern will be re-
duced/enlarged for output according to this scale. 
The scale factors mean the following: 

1.0 scale 1:1 
0.5 scale 1:2 
0.25 scale 1:4 etc. Practise the automatic wrap in conjunction with 

adjustment of plot scale, portrait / landscape and 
positioning of the plot frame. Apply scale 1:1 also 
and press the <F6>-key from time to time. 

Adjust to scale 1:2 by entering 0.5 into the field 
below enlargement (click, type, <ENTER>) and 
press the <F6>-key. You will notice that the plot 
frame now covers a greater are of the pattern. Re-
peat with other scales. Change also between por-
trait and landscape. 

Positioning the frame text 
A standard annotation at the plot frame can be out-
put with the picture for easy identification of the 
plot, especially on partial pictures when using auto-
matic wrap. It contains collection and style name, 
part number and field co-ordinates (picture 3-5). 
The number below textpositn. defines the position 
of the annotation at the right, left, upper or lower 
corner of the plot frame. “0” means no frame text is 
output. The text position number can be changed by 
clicking “<“ or “>“. 

The adapt option adjusts the scale so that the 
whole screen content fits the plot frame. Use this 
option for scaled printouts and sketches, especially. 

Position the plot frame 
Position the plot frame by dragging (cursor on plot 
frame, press left mouse button and move mouse) or 
clicking the menu function centred. Practise both 
options. Centred positions the plot frame centrally 
onto the picture. Practise positioning the plot frame 
in conjunction with changes in scale and format. 

Position the text at the left plot frame. 

Adjustment of +/-frame  
Clicking +/-frame determines whether the picture is 
plotted with or without a frame.  

+frame frame is plotted 
-frame frame is not plotted. 

When using the automatic wrap the setting should 
be +frame. The function formfeed relates to plotters 
with automatic paper feed only. 
 

 
Picture 3-4 
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Output of plot picture 
Output of the plot picture(s) 
(automatic wrap) ensues after hav-
ing clicked plot only.  GRAFIS cre-
ates the control information for the 
selected output device and opens 
the sub-menu plot output (right). 
When working with automatic wrap 
the fields for output have to be 
selected now. Fields can be selected 
for output by clicking single. Se-
lected fields are marked by two 
diagonals (see picture 3-5). Clicking 
select all will mark all fields for out-
put; clicking delete all will deselect 
all fields. 

Only marked fields are output ! 

Click start to send the control information to the 
output device (printer/plotter) directly connected to 
your PC for output of a picture or partial pictures. 
Naturally, the output device must be on-line. 

Output to file 

If output to file is selected the control information is 
saved to one or more files (automatic wrap creates 

a number of files). You are requested to enter the 
file name. If you enter A:\KATHRIN2.HGL for ex-
ample the control information is saved in the file 
KATHRIN2.HGL on the disk in drive A:. The follow-
ing is possible with control information saved in this 
way: 
1. The file(s) can be output on a different computer 

with an attached output device by copying the 
control file(s) to the port of the output device.  
Under Windows95/NT the file is be sent to the 
output device. 
The MS-DOS instruction to output the created 
file to an output device connected to LPT1: is for 
example: 

COPY   A:\KATHRIN2.HGL   LPT1: 
2. The file(s) can be read into Word for Windows 

or CorelDraw for further processing given that 
the relevant graphics filter is installed. As op-
posed to the clipboard, with this option the scale 
remains the same.  

3. The file(s) can be send to a different company via 
floppy disk or data transfer for plotting or crea-
tion of templates. This can ensue after adjust-
ment to the company’s output device. 

Note: When using automatic wrap, i.e. output of 
various partial pictures, the extension (here: HGL) is 
automatically replaced by consecutive numbers. 

Exercises 
1st Exercise 
Output the basic block "skirt 
after Hohenstein" in size 40 
in full scale to an A4-printer. 
Use +frame and frame text 
to be able to join the partial 
pictures frame by frame 
afterwards. 

2nd Exercise 
Output the following basic 
blocks: 
• "trousers after Hohenstein" scale 1:2, 
• "kimono" scale 1:3, 
• "bodice after Hohenstein" scale 1:5. 
If you know how to use Word for Windows or 
CorelDraw, import the plot pictures into these 
systems via the clipboard for processing. 

 

---------------
  select plot
  frames
    single
    select all
    delete all
---------------

 plot output
    start

 formfeed
---------------

Plot/Print

 

 
Picture 3-5 
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3.4 Stack 

The stack menu 
The stack menu is opened via 
the Extras | stack pull-down 
menu or from the toolbox. 
With the menu functions pat-
terns can be stacked at the 
pattern surround or at a con-
struction point or point of a 
line. The outlay function 
spreads all sizes next to one another in the order in 
which they are listed in the size table. The outlay is 
reset with repeated stacking or test run. 

Step-by-step guide 
Stack at pattern surround: 
⇒ Select the stack corner (le-

down,...) and click the piece 
Stack at a construction point or 
point of a line: 
⇒ Select click p, click l or click pl  

(below stack p:) and click the 
stack point in the construction 

⇒ if required: determine direction 
point in the same way 

Stack at pattern surround 
When stacking at the pattern sur-
round GRAFIS imperceptibly calcu-
lates the surrounding rectangle of 
the piece. The surrounding rectan-
gle, also called pattern surround for 
the basic block „bodice after 
Hohenstein“ is shown in picture 3-7. The pattern 
surrounds in the different sizes are stacked at the 
corner selected in stack at pattern surround (see 
picture 3-6). The option le-down stacks at the lower 
left corner of the surrounding rectangle for example. 

First, determine the stack corner. The active option 
is highlighted in red. Clicking  selects a different 
option. After having clicked an object of the con-
struction GRAFIS will stack the patterns at the se-
lected corner. 

Stack at a construction point or point of a line 
With the option click p you determine that the cur-
sor can select points of the construction as stack 
points, only. With click l only lines and with click pl 
only line fulcrums can be clicked (for more informa-
tion see Chapter 6). 
First, the required selection option (click p, click l or 
click pl below stack p) is to be selected. Then click 
the desired stack point in the construction. 

Then, a direction point can be determined, addition-
ally. The patterns remain stacked at the stack point. 
They are rotated about the stack point so that the 
direction from stack point to direction point is iden-
tical in all sizes (Picture 3-8) 

Surrounding rectangle of the pattern / pattern surround

 
Picture 3-7 

stack point direction point

 
Picture 3-8 

 

 stack at
 boundary

le-down
ri-down
le-up
ri-up

 stack point
pick P
pick L
pick PL

 stack direc
pick P
pick L
pick PL

 outlay
 measure

pick L

  

left-down right-up
 

Picture 3-6 
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3.5 Exercises Exercise 

Grade the basic block 001 “bodice after Hohenstein 
with normal dart” in the sizes 38, 40, 42 and 44 
without proportion class. Stack the patterns at the 
pattern surround and then, at the bust point. 

1st Exercise 
Grade the basic 
block 017 “skirt 
after Hohenstein” 
in four sizes and 
stack the patterns 
at the hip point of 
the side seam. 
Print the patterns 
in A4-format in 
scale 1:3 with plot 
frame so that you 
can join the patterns. 

 call 
 Extras |Edit Measurement Charts 
 Extras |Size Table 
 grading 
 Extras |stack 
  stack at pattern surround: le-up  activate 
  and click the construction 
The patterns are stacked at the construction point 
of the neck in the front (no picture). 
  stack p: click p  activate 2nd Exercise 
Click the bust point (Picture 3-7). Grade the basic 

block “kimono” in 
5 sizes and stack 
the patterns at 
different points or 
lines. 

Now stack at the corner shoulder/armhole and align 
the nest so that the shoulders are positioned on top 
of each other 
  stack p: click p  activate 
Click the corner point shoulder/armhole (Picture 3-
8 left nest). 3rd Exercise 
  direction p: click p activate Grade the shirt 

dress (ft) in 5 sizes 
and stack it at the sleeve point (see picture below). 

Click the corner point shoulder/neck (Picture 3-8 
right nest). 
Stack at the lower end of the centre front 
  stack p: click p  activate 
Click the corner point centre front/hem. The pat-
terns are still aligned along the shoulder. Only after  
  direction p: click p activate 
and clicking the corner point centre front/neck will 
you receive the nest according to Picture 3-9. 

Stack the patterns at different lines, different points 
and at the pattern surround. The bodice construc-
tion (front and back) is treated as one part in 
GRAFIS. Deriving pieces from the draft is content of 
Chapters 13 and 14. 

4th Exercise 
Grade the standard trousers (ft) in 5 sizes and stack 
the trousers at the knee line, left-down (see picture 
above). 
 

 

 

 
 

Picture 3-9 


